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Abstract 
 
Ever since it first appeared at the dawn of time, water has been in an unchanging state. Over the years, not 
much has been added or subtracted. Water is always moving because of the oceans, atmosphere, cryosphere, 
and land. The exchange of water between reservoirs in the ocean, atmosphere, and land is known as the 
hydrologic cycle. There are issues with the quality of the water supplies that are available. Water consumption 
per capita is an excellent predictor of peoples' quality of life as well as their economic and social position. 
Human health and happiness are directly tied to the quality of the water used. By 2025, it is anticipated that 
more than half of the world's population would be at risk from water shortages. The motive of the study is to 
identify the most sensitive zones in the study area with the help of GIS and to study the correlations amongst 
the various weather stations rainfall data. 
 
Introduction  
 
All living things require water, a naturally occurring resource. Everyone must have access to a sufficient, 
secure, and convenient source of water because it is essential to sustaining life. Human bodies are 60% water 
and plants are 90% water, respectively. In this way, water resources have been seen as significant reserves, 
and countries that are improving their infrastructure have also worked to understand the potential of these 
resources. Groundwater is essential for human consumption, habitat support, and river base-flow 
maintenance almost everywhere in the world. Because they were naturally filtered throughout their passage 
through the ground, they are frequently clear, colourless, and devoid of microbiological contamination and 
only require minimal treatment. 
Like the weather, the rainfall varies throughout Rajasthan. Most of the rain falls in the southwest of monsoon 
between July and September. The average number of rainy days usually varies from 6 to 42 days, depending 
on the area. The average annual rainfall is between 200-400 mm and as low as 150 mm in very dry areas. In 
the southeastern part of Rajasthan, rainfall reaches 1000mm. There are parts in western Rajasthan that 
receive very little rainfall and on average; it is only 100 mm per year. The Aravalli range receives high rainfall 
and low temperatures throughout the year. Winter People enjoy the winter season in Rajasthan from 
December to March. During this period, light winds blow from the north and northeast. Temperatures range 
from 4 to 28 degrees Celsius. In places like Mt Abu and Churu, temperatures drop to 0 degrees Celsius. 
The Bikaner region is so arid that some of the available rainfall is extremely low. Both summer and winter 
monsoon work here. In the summer the monsoon arrived in Rajasthan from two or more branches first the 
Arabian Sea Branch from the Arabian Sea, the Bikaner region receives very little rain because the monsoon 
branch corresponds to the width of Aravalli. And secondly the Bay of Bangol Branch from the Bay of Bangol, 
Bikaner received little rain from it and because the region is located in a shady rainy area on the Aravalli Range 
but the rainfall found in this branch is higher than the Arabian branch. In winter Bikaner receives occasional 
rain due to cyclonic disturbances in the west. 



Nat. Volatiles & Essent. Oils, 2021;8(2):150-162 

 

151 

Location and extent of the Bikaner district: 
 
Bikaner district is located in the northern part of Rajasthan. It is bounded on the north by Shri Ganganagar 
district, in the east by Churu and Hanumangarh, south by Jodhpur and Nagaur districts and west boundary is 
an international boundary with the Pakistan. It stretches between 27⁰ 09' 31.05” to 29⁰ 03' 14.17” North 
latitude and 71⁰ 50' 59.01’’ to 74⁰ 21' 59.21’’ 
 
East longitude covering an approximate area of 30,279 sq kms. It has ten tehsils including Bikaner, Bajju, 
Chattargarh, Khajuwala, Kolayat, Lunkaransar, Mahajan, Nokha, Poogal, and Dungargarh. The district does not 
have a properly evolved drainage system, almost whole of the district is part of an ‘Outside’ Basin. Bikaner 
district is administratively divided into nine blocks. 
 
Rainfall: 
 
The rainfall is very limited and erratic. The general distribution of rainfall across can be visualized from isohyets 
presented in the Plate III where major part of the district has received average rainfall less than 500mm in the 
year 2010. Most of the rainfall, i.e., approximately 90% of the total annual rainfall or more, is received during 
monsoon period and non-monsoon rainfall is very limited or negligible. The annual average rainfall was 458.2 
mm based on the data of available blocks while highest average annual rainfall is 595.4 mm in Dungargarh 
block. Lowest of minimum average annual rainfall was in Khajuwal block (288.0 mm). Lunkaransar block has 
received highest maximum annual rainfall of about 781.2 mm. 
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Fig 2: Average Rainfall of Bikaner District (Source: Water Resources Department, Rajasthan) 

 
 
Location and extent of the Bikaner district 
Map of Bikaner District (in legend weather stations) 
 
Methodology 
 
Annual rainfall and annual rainy days data of the Bikaner district from the year 2000 to 2021 is arranged in an 
excel sheet. Both data of excel sheet is represented in graphical form one is annual rainfall data and another 
is annual rainy days with a trend line. Years 2000, 2010 and 2020 data is saved in different three files so that 
the data is used in preparing the Bikaner district thematic map of three years. These three files are saved with 
the weather station and weather station’s latitude longitude so that it can be showed at its particular place in 
geographical map with the help of QGIS. 
 
Data processing with QGIS: 
 
QGIS (formerly Quantum GIS) is an open source geographic information system (GIS). This software is a free 
alternative to proprietary GIS software such as ESRI’s ArcGIS products which can be very expensive. QGIS 
incorporates similar functions and features as its proprietary counterparts and allows users to display, 
manipulate and create spatial data. The QGIS is open source and very simple software. There are two simple 
ways to import the point data into QGIS, depending on the type of data like shapefile, CSV file, excel 
spreadsheet. 
 
SHAPEFILE DATA 
 
A shapefile is a simple, nontopological format for storing the geometric location and attribute information of 
geographic features. Geographic features in a shapefile can be represented by points, lines, or polygons 
(areas). The workspace containing shapefiles may also contain dBASE tables, which can store additional 
attributes that can be joined to a shapefile's features. To import a shape file, click on the ‘Layer’ tab in the 
upper left hand corner of the screen, and select the ‘Add Vector Data’ tab. A window will then prompt you to 
navigate to your saved shape file dataset on your hard drive. Afterwards click ‘open’ and you should see your 
point data on the main display. 
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Figure 4: Add Vector Layer in QGIS 

 
EXCEL SHEET DATA 
Spreadsheets are composed of columns and rows that create a grid of cells. Typically, each cell holds a single 
item of data. Here's an explanation of the three types of data most commonly used in spreadsheet programs: 
1. Text data, also called labels, is used for worksheet headings and names that identify columns of data. 
2. Number data, also called values, is used in calculations. By default, numbers are right-aligned in a cell. In 

addition to actual numbers, Excel also stores dates and times as numbers 
3. Formulas are mathematical equations that work in combination with data from other cells on the 

spreadsheet. Simple formulas are used to add or subtract numbers. Advanced formulas perform 
algebraic equations. 

 
If the data for QGIS is in the form of an Excel spreadsheet, where the points have associated latitudes, 
longitudes and attribute data, we have to save it as a comma-separated value (CSV) file before trying to import 
it into QGIS. To import a CSV file, click on the ‘Layer’ tab in the upper left hand corner of the screen, and select 
the ‘Add Delimited Text Layer’ tab. 
 
A window will then prompt you to navigate to your saved CSV file on your hard drive. Assign a layer name for 
the output point data. Select the ‘longitude’ field to represent the x-values and the ‘latitude’ field to represent 
the y-values. You may be also prompted to provide a map projection for the data (sometimes this is done 
automatically). If so, select the appropriate geographic coordinate system for your dataset. Then click ‘ok’ to 
load the x and y point data. The next step when loading a CSV file is exporting the loaded point data (from the 
previous step) to a shapefile. To do this in QGIS, right-click on the loaded point data layer and click the ‘Export 
> Save features as’ tab. 
 
A window will then prompt you to pick the format of the file being saved, choose ‘ESRI Shapefile’. Browse for 
a location to save the shapefile on your hard drive and assign the filename for the output shapefile. You will 
also need to specify a projected coordinate system for the output shapefile, in order to run interpolations on 
it in later steps. And lastly, check the ‘Add saved file to map’ box. Then click ‘ok’. 
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Add 
DText Layer in QGIS 

 

 
ESRI Shapefile in QGIS 

 
Creating the IDW Interpolated Raster Surfaces 
 
Interpolation is a commonly used GIS technique to create a continuous surface from discrete points. A lot of 
real-world phenomena are continuous – rainfall, elevations, soils, temperatures etc. If we wanted to model 
these surfaces for analysis, it is impossible to take measurements throughout the surface. Hence, the field 
measurements are taken at various points along the surface and the intermediate values are inferred by a 
process called ‘interpolation’. In QGIS, interpolation is achieved using the built-in Interpolation tools from the 
Processing toolbox. 
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Interpolation in QGIS 

 
The interpolation method that will be used in the project is the IDW interpolation. Click on the ‘Processing’ 
tab and select ‘Toolbox’. The ‘Processing Toolbox’ panel will then appear on the right side of the map view. 
You will notice that QGIS draws tools from 8 different GIS sources including its own QGIS tool selection. The 
easiest way to find an appropriate interpolation tool is to type ‘Interpolation’ into the upper search column. 
Now choose Inverse Distance Power Interpolation and double click on the IDW Interpolation. The IDW 
Interpolation inputs window will then appear, which allows you to input the data layer being interpolated and 
customize the interpolation based on your needs. For the ‘Points’ input use the ‘Weather Station’ shape file 
layer. For the ‘Attribute’, select Annual Rainfall from the drop-down selection. 
 
Use the default values for ‘Target Grid’, ‘Distance Coefficient’, ‘Inverse Distance Power’ etc. as they are 
appropriate for the data distribution in this study. And lastly, assign a location to save the output raster ‘Grid’, 
and check the ‘open output file after running algorithm’ check-box. Click ‘Run’. The IDW interpolation tool will 
then output a black and white interpolated raster surface onto the map area. Drag the grid layer bellow the 
point shape file layer and rename it by right-clicking on the raster grid and selecting ‘rename’. The next step 
is to assign a colour ramp to this reclassified raster layer. To do this, right-click on the ‘renamed file’ and select 
‘properties’. Select the ‘Symbology’ tab, and then pick ‘Single band pseudocolor’ in the ‘render type’ drop-
down box. 
 
Then in the ‘Generate new colour map’ area, choose the ‘spectral’ colour ramp, check the ‘invert’ check-box, 
select the ‘Equal Interval’ mode and 6 classes. Assign a min value and max value, and then click the ‘classify’ 
button. This will create a 6 class colour which needs to be reclassified based on the values of the ‘reclassified 
grid’. After modifying the colour ramp values to reflect the correct range of values from the reclassified grid, 
click ‘apply’ and ‘ok’ and you will now have coloured map of the file. The last step of this mapping process is 
to create a polygon of the lake which will be used as a mask to clip the interpolation surface. 
 
Creating Clipping Polygon and Clipping Interpolation Surface 
 
To create a clipping mask for the interpolation raster surface you have to digitize a polygon of the interested 
area boundary and then clip the interpolated surfaces with it, so that the interpolation does not extend onto 
land (which may have very different As concentrations compared to water). In order to do so, a new shapefile 
needs to be created. Under the ‘Layer’ tab, click on ‘Create Layer’ and then select ‘New Shapefile Layer’. 
 
In the ‘New Shapefile Layer’ window, select the option to create a ‘polygon’ in the ‘type’ field. Then specify 
the correct projection for the shapefile. Seeing that this shapefile is just going to be used to create a clipping 
mask polygon, no ‘new attributes’ need to be assigned. Click 'ok'. A window will then appear which allows 
you to specify a filename and location to save the new shapefile. Call is ‘Clip Polygon’, and save it.You will now 
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notice your new polygon shapefile in the list of layers. The next step will be digitizing a polygon of the 
interested area. Right-click on the ‘Clip Polygon’ layer and select the ‘Toggle editing’ button. 
 
Then click the ‘Add Feature’ button to start creating the polygon. Start digitizing the polygon by clicking on 
the edge of the interested area and following the boundary all around the area. Use as many digitizing points 
as possible to ensure an accurate polygon. Once you have finished digitizing your polygon, right click on the 
last point. A window will appear that will allow you to specify an id for the polygon, assign it a value of ‘1’. 
Then click 'ok'. Now that we have our Area polygon, we can save the edits made to the shapefile and close 
the editor. Click on the ‘current edits’ button and select the ‘save for all layers’ button. Then right-click on the 
Clip Polygon shapefile layer and click on the ‘Toggle editing’ button to stop editing the polygon. 
 

 
Figure 8: Bikaner shapefile in QGIS 

 
Now we are ready to clip the ‘Reclassified grid’ using the ‘Clipping Polygon’. To do so, search for the tool ‘Clip 
grid with polygon’ in the processing toolbox, and open it. In the ‘clip grid with polygon’ tool window, assign 
the ‘Reclassified Grid’ as the input raster layer and the ‘Clip Polygon’ as the input polygon. Specify an output 
filename ‘Bikaner map’ and click run. You will notice that the reclassified grid is now clipped, but the default 
original greyscale colouring has returned. There is a quick way to re-symbolize the clipped raster with the 
appropriate colour ramp. 
 
Right-click on the ‘reclassified grid’, which still has its intact colour ramp and open the properties menu. Click 
on the ‘export colour map file’ button, and save the text file to hard drive. Then re-open the properties menu 
for the ‘Bikaner map’ raster, select the ‘style’ tab, and then pick ‘Singleband Pseudocolor for the ‘render type’. 
Then click on the ‘load colour map from file button’ and open the saved text file from the earlier step. You will 
now notice that your legend is back to the original format. 
 
And now the map is complete and ready to be checked for accuracy. When you inspect the As concentration 
point values and the interpolated surface value under each point (looking at the legend), you will see that all 
the points fall in the correct interpolated value range area, indicating a good interpolation job. Now that the 
IDW interpolation map is complete. 
 
Exporting the Final Maps 
 
Under the ‘Project’ tab, select “New Print Layout’. Assign a ‘Create Print Layout’ that will be used for the new 
print composer (For example: ‘BIKANER MAP 2000’). Under the ‘Layout’ tab, you can add a number of map 
elements to the print composer including the actual map, a legend, scale bars, etc., depending on the nature 
and purpose of the final map. 
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Make sure you zoom to the layer extent of the Bikaner map 2000 first before adding it as a map to the print 
composer, text editing for the ‘label’ is done in a text editing box on the right hand side of the print composer 
window. There is a wide variety of graphics editing tools within this print composer, so feel free to explore 
and play with them before exporting the final map. 
 
The last step of this will be exporting the map and for this there are a number of formats available to export 
the final map as, which including: JPEG file, PDF or as an SVG file. To export the map, click on the ‘Layout’ tab 
and select the ‘Export as Image’ tab. Assign a file name to the exported image like PNG, JPG, JPEG file etc., 
and click save. 
 

 
Export map in QGIS 

 

 
Fig 10: Export map as an image in QGIS 
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Results and Discussion 
 

YEAR AVERAGE RAINFALL AVERAGE RAINY DAYS 
   

2000 270 12 
   

2001 275 17 
   

2002 61 7 
   

2003 300 18 
   

2004 158 12 
   

2005 296 20 
   

2006 195 14 
   

2007 274 19 
   

2008 351 23 
   

2009 209 15 
   

2010 427 22 
   

2011 341 21 
   

2012 336 19 
   

2013 308 22 
   

2014 299 21 
   

2015 510 30 
   

2016 298 20 
   

2017 254 19 
   

2018 271 14 
   

2019 285 23 
   

2020 298 22 
   

2021 321 21 
   

Table: Bikaner district Average Rainfall and Average Rainy days 
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21 Bikaner District Average Rainfall Data and Rainy Days 
 
With the help of average rainfall data we can say that Bikaner district received rainfall between a ranges of 
200-500 mm in last 22 years and only one time the rainfall crosses this range in these years. In the year 2015 
the rainfall is more than this range with nearly 510 mm and in the year 2010 rainfall is very low and it goes 
nearly 180 mm. Bikaner is close to 300mm average to be considered normal rainfall in the region. With the 
help of average rainy days data we can say that Bikaner district rainfall days are between a ranges of 10-30 in 
last 22 years and average rainfall data show a gradual increases in the last years in the region. Average rainy 
days are consistently following an increasing pattern. 
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Figure 10: Bikaner district average rainfall data 
 
Bikaner Rainfall Distribution 2000 
 
In Bikaner district there are six weather station in 2000. If we go through the complete rainfall distribution 
data of Bikaner district for year 2000 as per above Thematic map, we found that in the year 2000 rainfall 
distribution in Bikaner district is being decreases when going east to west direction of Bikaner district. 
Lunkaransar block get highest rainfall during the whole year and Nokha block is on second position. Bikaner 
and Khajuwala block get lowest rain fall during the whole year while Pungal block get average rainfall. 
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Bikaner thematic map 2000 
Bikaner Rainfall Distribution 2010 
 

 
 
In Bikaner district there are eight weather station in 2010. If we go through the data of complete rainfall 
distribution at each weather station as per above Thematic map, we found that in the year 2010 rainfall 
distribution in weather stations of Bikaner district is being decreases when going east to west direction. 
Lunkaransar block get highest rainfall during the whole year and Nokha block is on second position. Khajuwala, 
Pungal and Chattargarh blocks get lowest rain fall during the whole year. Magra and Bikaner blocks get average 
rainfall. 
 
Bikaner thematic map 2010 
 
Bikaner Rainfall Distribution 2020 
 

 
Bikaner thematic map 2020 
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Bikaner district there are nine weather station in 2020 and Bajju is latest weather station. If we go through 
the complete rainfall distribution data of Bikaner district for year 2020 as per above Thematic map, we found 
that in the year 2020 rainfall distribution in Bikaner district is also being decreases when going south to north 
direction of Bikaner district. Kolayat and Nokha blocks get highest rainfall during the whole year. Lunkaransar 
and Khajuwala blocks get lowest rain fall during the whole year. Bikaner, Chattargarh and Bajju blocks get 
average rainfall throughout the year. 
 
Conclusion 
The present study reveals that rainfall pattern of Bikaner is increasing with the time as the study depicted. 
The trend of rainfall pattern is shall ergative but have increased in spells especially including pre monsoon 
shower. Despite having increase in precipitation the recharge rate of water is shell low due to high 
temperature and low permeability of the soil. The introduction of IGNP canal is in various reason of the 
Bikaner supports micro climate condition which helps to a consequent increase in trends of rainfall in coming 
years so far. 
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